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1 Document information

1.1 Target audience for this manual
This manual should support during the operation of Tankvision Professional NXA85. It deals 
with the usage of the movement system.
This manual is designed as an Operators aide to using the software.
Beside basic PC operating knowledge no special training is needed to perform the Tank 
Gauging System operations. Nevertheless it is recommended receiving a training on the 
system by Endress+Hauser.

1.2 Version history

Due to the certification process with weights and measures agencies, the latest 
software version might only be certified at a later stage. Also some features might be 
incompatible with the weights and measure regulations and can therefore not be 
combined.

1.3 Document function

1.3.1 Used symbols

Safety symbols

Document version Valid for SW version Changes to the previous version

BA00395G/00/EN/13.10 18.0.0 Initial version

BA00395G/00/EN/14.14 18.0.2 and 18.0.3 New layout; Enhanced Product, Tank 
and Movement functionality

BA00395G/00/EN/15.16 18.0.2 and 18.0.3 New features

BA00395G/00/EN/16.17 18.1.1 Unification of the W&M and the non 
W&M software packages.

BA00395G/00/EN/17.19 18.2.5 Optional software component 
Movements Ticketing added.

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

DANGER

WARNING

CAUTION

NOTICE
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Electrical symbols 

Symbols for certain types of information

Symbols in graphics

Symbol Meaning

A0011197

Direct current
A terminal to which DC voltage is applied or through which direct current flows.

A0011198

Alternating current
A terminal to which alternating voltage is applied or through which alternating current flows.

A0011200

Ground connection
A grounded terminal which, as far as the operator is concerned, is grounded via a grounding 
system.

A0011199

Protective ground connection
A terminal which must be connected to ground prior to establishing any other connections.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

)

*

1. 2. 3.

1. 2. 3.

-

.
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1.4 Documentation

1.4.1 Operating instructions

Document number Instrument Type of Document

BA00390G/00 Tankvision Professional System Configuration

BA00391G/00 Tankvision Professional Data Communications Controller

BA00392G/00 Tankvision Professional Installation

BA00393G/00 Tankvision Professional Maintenance

BA00394G/00 Tankvision Professional Movements System Configuration

BA00395G/00 Tankvision Professional Movements Operation

BA00396G/00 Tankvision Professional System Operation

BA01293G/00 Tankvision Professional OPC Tank Data Server

BA01294G/00 Tankvision Professional OPC TG Client Configuration

BA01295G/00 Tankvision Professional Web Server/Client System Operation

BA01363G/00 Tankvision Professional Product and Tank Data Synchronization

BA01653G/00 Tankvision Professional Simple Movements

BA01654G/00 Tankvision Professional System Monitor
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2 Identification

2.1 Product identification
The following options are available for identification of the software:

• Nameplate specifications
• Order code with breakdown of the software features on the delivery note
• Enter serial numbers from nameplates in W@M Device Viewer

(www.endress.com/deviceviewer): All information about the software is displayed.

For an overview of the technical documentation provided, enter the serial number from the 
nameplates in the W@M Device Viewer (www.endress.com/deviceviewer)

2.2 Nameplate

nameplate

1 Address of manufacturer
2 Device name 
3 Order code 
4 Extended order code (Ext. ord. cd.) 
5 Serial number (Ser. no.) 
6 Certificate and approval relevant data
7 Barcode
8 CE mark

250002972--

Order code:

Ext. Order code:

Ser.-No.:

Tankvision

1 2 3 4 5

6

7

8
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2.3 Order code and device version
To find out the version of your software, enter the order code indicated on the 
nameplate in the search screen at the following address: 
www.products.endress.com/order-ident

2.4 Device documentation
The information required to retrieve the documentation can be found on the nameplate of 
the device.

Technical documentation can also be downloaded from the Download Area of the 
Endress+Hauser web site: www.endress.com→ Download. However this technical 
documentation applies to a particular instrument family and is not assigned to a 
specific device.

2.4.1 W@M Device Viewer
Launch the W@M Device Viewer: www.endress.com/deviceviewer

Enter the serial number (Ser. no.) of the device: see nameplate.
 All the associated documentation is displayed.

2.4.2 Endress+Hauser Operations App
The Endress+Hauser Operations App is available both for android smart phones 
(Google Play Store) and for iPhones and iPads (App Store).

Via the serial number:

Launch the Endress+Hauser Operations App.

Enter the serial number (Ser. no.) of the device: see nameplate.
 All the associated documentation is displayed.

2.5 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

ModbusTM

Registered trademark of Schneider Electric, USA

Java®

Registered trademark of Sun Microsystems, Inc.

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Android® and Google Play® are registered trademarks of Google Inc.

iPhone® and iPad® are trademarks of Apple® Inc., registered in the U.S. and other countries.

1.

2.

1.

2.
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3 Basic safety instructions

3.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfill the 
following requirements: 

• Trained, qualified specialists: must have a relevant qualification for this specific function 
and task

• Are authorized by the plant owner/operator
• Are familiar with federal/national regulations
• Before beginning work, the specialist staff must have read and understood the instructions 

in the Operating Instructions and supplementary documentation as well as in the 
certificates (depending on the application)

• Following instructions and basic conditions

The operating personnel must fulfill the following requirements:

• Being instructed and authorized according to the requirements of the task by the facility's 
owner operator

• Following the instructions in these Operating Instructions

3.2 IT security
We only provide a warranty if the device is installed and used as described in the Operating 
Instructions. The device is equipped with security mechanisms to protect it against any 
inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide 
additional protection for the device and device data transfer must be implemented by the 
operators themselves.

3.3 Designated use

3.3.1 Application
Tankvision Professional is specifically designed for operators of bulk storage facilities, 
marketing terminals, refineries and pipelines. It is designed to handle all the data 
acquisition, supervisory control and monitoring required in a single fully integrated solution.

Tankvision Professional integrates all major types of tank measurement instruments into 
one system.

All measured and calculated tank parameters are accessible to your tank farm and terminal 
operators as well as to connected host systems.
Multi-user operation is provided by the built-in Web Server offering the opportunity to 
access data at any connected location (local/remote) e.g. for administrative and accounting 
purposes.

3.4 Workplace safety
For work on and with the device: 

• Wear the required personal protective equipment according to federal/national 
regulations.

• Switch off the supply voltage before connecting the device.
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3.5 Operational safety
Risk of injury!

• Operate the device in proper technical condition and fail-safe condition only.
• The operator is responsible for interference-free operation of the device.

Conversions to the device
Unauthorized modifications to the device are not permitted and can lead to unforeseeable 
dangers

• If, despite this, modifications are required, consult with Endress+Hauser.

Repair
To ensure continued operational safety and reliability,

• Carry out repairs on the device only if they are expressly permitted.
• Observe federal/national regulations pertaining to repair of an electrical device.
• Use original spare parts and accessories from Endress+Hauser only.

3.6 Product safety
The device is designed to meet state-of-the-art safety requirements, has been tested and left 
the factory in a condition in which it is safe to operate. The device complies with the 
applicable standards and regulations as listed in the EC declaration of conformity and thus 
complies with the statutory requirements of the EG directives. Endress+Hauser confirms the 
successful testing of the device by affixing to it the CE mark.
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4 Movements Operation Introduction
Movements are at the core of operations at a tank farm. If the tank farm is built to store bulk 
liquids, then movements are a necessary part of the operations there as the storage is only 
useful if you can move products in and out of the facility.
The movements system is a module in the tank gauging system designed to assist in the safe 
management of the transfer of products on and off and around the site being monitored. It 
can provide operators with notifications of the progress of movements, some enforcement 
of safe operating procedures and reporting of inventory changes.
This manual is a companion to the Movements Configuration manual. This manual 
describes the operational aspects of the full movements system and assumes that the reader 
is presented with a properly configured movement system to start with, many of the key 
features in movements are optional and are controlled by the configuration options. It is 
recommended that the person responsible for the implementation of policies regarding the 
movement operations at the site reads both manuals fully.

BA00395GEN_0076

The main interface for using the movements is the movements client, the main window of 
which is shown above. There are 3 views of movements in the system, divided by the status 
of the operation: planned, open and closed. Clicking the labels at the top of the black 
movement area selects the movements to be shown. This window is central to the use of the 
full movements package, and operators should become familiar with its operation.
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5 Quick Start Guide
This section shows how to plan movements for a number of common scenarios.

The scenarios will not necessarily be applicable to every installation.

5.1 Receipt from a Ship
From the Main Summary screen (→ ä 11) click the Create new movement button 

.
The first page of the New Movement wizard will be displayed:

BA00395GEN_0077

Enter a movement name.
If no name is entered, the ID of the movement will be used as the name. The movement 
name for a movement is displayed in the first column on the summary screen.

Select a product. This is for information purposes only and may be displayed on the 
summary screen.

Select a movement type of Receipt.

Select a movement class of Ship.

Click the Next button.
The subject page is now displayed:

1.

2.

3.

4.

5.

6.
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BA00395GEN_0078

Enter the name of the subject of the movement.
Typically this would be the name of the ship. This value will be displayed in the Subject 
column on the summary screen.

For the purposes of this exercise, it is assumed that the ship cargo is 30,000 m³ of DERV. The 
volume and density of the cargo are generally provided at standard conditions, in Europe and 
the US standard conditions are typically atmospheric pressure and 15 °C or 60 °F 
respectively. If your receipt documentation provides a cargo weight, as might be the case for 
a road delivery for instance, select the appropriate target type.

Enter the Planned Quantity, as defined by the choice of target type.

Enter the Reference Density, this will be used by the system to convert between the 
different quantities.

Click the Next button.
The Tank Movements page will be displayed:

7.

8.

9.

10.
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BA00395GEN_0079

When you open the page the first time a line will be displayed showing the first tank in 
your system selected. Select the first tank to be filled and then select Fill in the 
Movement Control column. The planned volume will be automatically calculated and 
will be grayed out so that it cannot be amended.

If your tank does not currently have a valid level, as is frequently the case with radar 
gauges on empty tanks, or your tank is not yet ready to receive a cargo you can enter 
your own level and temperature for the purposes of planning. When you come to open 
the movement the current live level will be taken at that point and the validity of your 
planned quantity will be checked to prevent you from attempting to over fill the tank.

Click the Add to create a second entry. Select the tank ID of the second tank to be filled 
and then select Fill in the Movement Control column. Continue until enough capacity 
for the cargo has been allocated. Usually the allocated cargo will not fill all the tanks you 
select, so the final tank will be set as No Control.

No Control does not mean that the movement will not be subject to any controls when 
you come to run it. The usual procedure when receiving a large shipment that won’t fit 
in a single tank is for a number of tanks to be lined up for the receipt and to change the 
tank while the ship is pumping as they become full, before finally depositing the 
balance in the last tank. When you select a tank to be filled the target level is 
determined to be the maximum operating level for the tank, the final No Control tank 
has its target level calculated by estimating the product level to accommodate the 
remaining volume of the movement at the time the final tank is opened.

You can remove a tank from the list by clicking the  button at the left of each tank row.

Click on the Next button. If the Timed Activities page is displayed click the Next button 
again.

The Summary page is now displayed.

Check that the details for the receipt are correct and then click the Finish button.
The movement planning is now complete.

11.

12.

13.

14.
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5.2 Load to a Pipeline
On the Summary screen (→ ä 11) click the Create new movement button .
The first page of the New Movement wizard will be displayed:

BA00395GEN_0081

Enter a movement name.
If no name is entered, the ID of the movement will be used as the name. The movement 
name for a movement is displayed in the first column on the summary screen.

Select a product. This is for information purposes only and may be displayed on the 
summary screen.

Select a movement type of Load.

Select a movement class of Pipeline.

The setting for Calculate ETF Based On determines how the Estimated Time to Finish 
is calculated. The options are several different flow rates calculated within the tank 
gauging system’s communications layer. Which you choose has little bearing on the 
way you run the movement, it is really a personal choice as to whether you would like 
a slow responding steady flow rate or a quick responding but potentially erratic one.

Click the Next button.
The subject page is now displayed:

1.

2.

3.

4.

5.

6.
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BA00395GEN_0082

Enter the name of the subject of the movement.
Typically this would be the name of the pipeline. This value will be displayed in the 
Subject column on the summary screen.

Leave the Movement Control field as Specified and the Target Type field as Volume.

It is possible to choose the different volume and mass types to define your movement 
quantity, which you select will largely depend on the information you are provided with 
and the limitations of your instrumentation. If you need to ignore the effects of free 
water from your movement, choose Total Observed Volume.

Enter the planned quantity.

Click the Next button.
The Tank Movements page will be displayed:

BA00395GEN_0083

7.

8.

9.

10.
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The first row will be populated with the first tank in your database.

Select the Tank ID of the first tank in the movement and then enter the quantity that is 
to be taken out of it. 

Click Add to include additional tanks in the movement. If the tank you select currently 
has an invalid level, or you expect it to be different when you open the movement you 
can edit the start level, which defaults to the current tank level.

The same tank can be added multiple times; if you expect that the tank will be refilled 
during the course of the discharge to the pipeline.

When the details of the first entry are amended, a second entry is automatically created.

Select the Tank ID of the second tank in the movement and then enter the quantity that 
is to be taken out of it. Continue until all of the tanks in the movement have been 
included.

Check that the Total Volume for the tanks matches the Planned Volume for the 
pipeline (i.e. the Discrepancy is zero).

Click on the Next button. If the Timed Activities page is displayed click the Next button 
again.
The Summary page is now displayed.

Check that the details for the movement are correct and then click the Finish button.
The movement planning is now complete.

11.

12.

13.

14.

15.

16.
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5.3 Tank to Tank Transfer
On the Summary screen (→ ä 11) click the Create transfer button .
The Simple Tank Transfer page will be displayed:

BA00395GEN_0084

Enter a movement name.
If no name is entered, the ID of the movement will be used as the name. The movement 
name for a movement is displayed in the first column on the summary screen.

Select a Source Tank and a Destination Tank for the movement.

Leave the Movement Control as Specified and the Stop Gauge By as Volume.

Enter the planned volume.

Click the OK button.
The movement planning is now complete.

The simple tank transfer screen is limited to creating one to one movements of product 
between two tanks. The movements system is capable of managing more complex one 
to many and many to one transfers, however these need to be configured using the 
movements wizard.
The simple tank transfer is provided as a convenient way to create the many 
"housekeeping" movements which occur on many sites.

1.

2.

3.

4.

5.

6.
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6 Alarms
In addition to the alarms that are generated by Tankvision Professional, the movements 
system has some unique alarms. Default settings for the alarms are configured from the 
Default Alarm Configuration screen (see Movements Configuration Manual BA00394G 
for more details). Alarm settings for individual movement components can be modified (see 
Tank Alarm Configuration [→ ä 19] and Timed Activity Alarm Configuration [→ ä 20] for 
more details).
For more details about alarm annunciation and acknowledgement see the appropriate 
section of the System Operation manual BA00396G.

6.1 Movement Alarms

6.1.1 Net Flow Alarm
For movements which are tank to tank transfers, a net flow alarm can be enabled. If the total 
net flow of the open tanks in the movement exceeds the pre-defined threshold an alarm is 
raised. By default the severity of the alarm is High. The description of the alarm will be
movement: Net movement flow is greater than amount,
where movement is the name of the movement and amount is the pre-defined threshold.

6.2 Tank Alarms
The following alarms may be raised for a tank in a movement when the status of the 
corresponding movement component is either Open or Reopened.

6.2.1 Time to Target Alarms
There are two Time to Target alarms for each tank in a movement (including the subject 
tank if the movement is a transfer). These are raised when the ETF for the movement 
component drops below a pre-defined threshold. By default the severity of the first of these 
alarms is Low and the severity of the second of these alarms is High. Both alarms will have 
a description of
movement - tank ID: Target level will be reached in n minutes,
where movement is the name of the movement, tank ID is the ID of the tank which is 
approaching the completion time and n is the time remaining (in minutes).

6.2.2 Approaching Target Level Alarms
There are two Approaching Target Level alarms for each tank in a movement (including 
the subject tank if the movement is a transfer). These are raised when the product level in 
the tank reaches a pre-defined distance from the target level for the tank. By default the 
severity of the first of these alarms is Low and the severity of the second of these alarms is 
High. Both alarms will have a description of
movement - tank ID: Product level is within distance of target level,
where movement is the name of the movement, tank ID is the ID of the tank which is 
approaching the target level and distance is the distance remaining to the target level.

6.2.3 Target Level Achieved Alarm
The Target Level Achieved alarm is raised when the target level is reached for a tank in a 
movement (including the subject tank if the movement is a transfer). By default the severity 
of this alarm is High. The description of the alarm will be
movement - tank ID: Target level achieved,
where movement is the name of the movement and tank ID is the ID of the tank which has 
achieved its target level.



Alarms Tankvision Professional NXA85 - Movements System Operation

20 Endress+Hauser

6.2.4 Target Level Exceeded Alarm
The Target Level Exceeded alarm is raised when the target level for a tank is passed by 
more than a pre-defined distance. By default the severity of this alarm is Critical. The 
description of the alarm will be
movement - tank ID: Target level exceeded,
where movement is the name of the movement and tank ID is the ID of the tank which has 
exceeded the target level.

6.2.5 Low Flow Alarm
The Low Flow alarm is raised when the flow rate for a tank is lower than a pre-defined 
threshold.  By default the severity of this alarm is High. The description of the alarm will be
movement - tank ID: Flow rate is less than amount,
where movement is the name of the movement, tank ID is the ID of the tank which has the 
low flow rate and amount is the pre-defined threshold.

6.2.6 Reverse Flow Alarm
The Reverse Flow alarm is raised when the flow for a tank is in the opposite direction to that 
expected by the movement. By default the severity of this alarm is High. The description of 
the alarm will be
movement - tank ID: Flow is not in expected direction,
where movement is the name of the movement and tank ID is the ID of the tank which has 
a flow in the wrong direction.

6.3 Timed Activity Alarms
The following alarms may be raised for a timed activity in a movement when the status of 
the corresponding movement component is either Open or Reopened.

6.3.1 Time to Finish Alarms
There are two Time to Finish alarms for each timed activity in a movement. These are raised 
when the time remaining for the activity drops below a pre-defined threshold. By default the 
severity of the first of these alarms is Low and the severity of the second of these alarms is 
High. Both alarms will have a description of
movement - tank ID (activity): Activity will be completed in n minutes,
where movement is the name of the movement, tank ID is the ID of the tank, activity is the 
description for the activity and n is the time remaining (in minutes).

6.3.2 Activity Finished Alarm
The Activity Finished alarm is raised when the length of time a timed activity has been open 
matches the planned time for the activity. By default the severity of this alarm is High. The 
description of the alarm will be
movement - tank ID (activity): Activity completed,
where movement is the name of the movement, tank ID is the ID of the tank and activity is 
the description for the activity.
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6.3.3 Activity Overdue Alarm
The Activity Overdue alarm is raised when the length of time a timed activity has been open 
exceeds the planned time for the activity by a pre-defined amount. By default the severity of 
this alarm is Critical. The description of the alarm will be
movement - tank ID (activity): Activity completed n minutes ago,
where movement is the name of the movement, tank ID is the ID of the tank, activity is the 
description for the activity and n is the time by which the completion time has been exceeded 
(in minutes).
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7 Summary Screen
The movements summary screen can be accessed from the Tankvision Professional Home 
Page in the following ways:

• By selecting the Movements entry from the View menu.
• By clicking the Movements button  on the shortcut bar.
• By selecting the Movements entry from the Movements menu on the movements bar.

The movements summary screen displays details of all planned and open movements. In 
addition, movements that have been closed within the last 24 hours are displayed.
The summary screen starts with the planned movements displayed (→ ä 11).

Viewing open and closed movements
Open movements can be viewed by clicking on the Open tab. Similarly movements that have 
been closed in the last 24 hours can be viewed by clicking on the Closed tab.

Adjusting the text size
The size of the text in the summary screen can be increased by clicking the Make text larger 

 button on the toolbar or selecting View → Text Size → Make Larger from the menu. 
Similarly it can be decreased by clicking the Make text smaller  button on the toolbar or 
selecting View → Text Size → Make Smaller from the menu.

Adjusting the width of columns
The width of the columns in the summary screen can be changed by holding the left-mouse 
button down over the dividing line between two headers and then dragging it left or right.

Movement components
The movement details that are displayed on each of the views (Planned/Open/Closed) can 
also be amended. See the Movements Configuration Manual BA00394G for more details.

Movement components can be selected by clicking on them with the mouse. If more 
than one component needs to be selected, the Ctrl-key should be held down whilst 
clicking on the additional components to be selected.
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7.1 Toolbar Icons

Create transfer (→ ä 32)

Create new movement (→ ä 24)

Open/Reopen movement (→ ä 37)

Suspend movement (→ ä 40)

Close movement (→ ä 41)

Cancel movement (→ ä 42)

Movement Log (→ ä 48)

Movement History (→ ä 50)

Movement Certificate (→ ä 51)

Historical Movements (→ ä 54)

Make text larger

Make text smaller
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8 Movement Life Cycle

8.1 Planning Movements
New movements can be created using the new movement wizard or the simple tank transfer 
screen.

8.1.1 New Movement Wizard
The New Movement wizard is run by clicking the Create new movement button  on 
the toolbar, or selecting New from the Movements menu.

Movement Details Page

The first page in the New Movement wizard is the Movement Details page:

BA00395GEN_0085

• Movement Name
The name used to identify the movement. If no name is entered, this will be set to the 
movement ID.

• Product
The product involved in the movement. This is for information only and does not have to 
relate to the product in the receipt or load tank(s). It defaults to the product selected in the 
Movement System Settings screen (see Movement Configuration Manual BA00394G for 
more details).

•
Toggles Product between product name and product ID.

• Movement Type
The type of the movement. This must be one of the four pre-defined types which are 
selectable from the drop-down list.

• Movement Class
The class of the movement. This drop-down list will only contain the movement classes 
which have been associated with the selected Movement Type (see Movement 
Configuration Manual BA00394G for more details).

• Calculate ETF Based On
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This field allows the selection of the type of volume flow rate which is to be used to 
calculate the ETF of the movement when it is open.

• Custom Data Fields
There are up to five custom data fields below the Calculate ETF Based On field. These are 
dependent on the selected Movement Class (see Movement Configuration Manual 
BA00394G for more details).

Subject Page

The Subject page is used to enter details of the subject of the movement. In the case of a 
receipt or a one-to-many transfer, this is the source. In the case of a load or a many-to-one 
transfer, this is the destination.

BA00395GEN_0086

This page contains the following fields:

• Subject
This field is only displayed for load and receipt movement types. It is used to enter 
information about the subject of the movement, for example the name of a ship, or the 
registration plate of a lorry.

• Source/Destination Tank ID
This field is displayed instead of the subject field for transfer movement types. The source 
or destination tank is selected from a drop-down list of all the tanks in the system.

• Movement Control
Determines the planned quantity for the subject of the movement.

Receipt Load Transfer
(1-to-Many)

Transfer
(Many-to-1)

Fill x x x  The planned quantity is the 
quantity required to fill the 
subject (destination) tank to 
the maximum operating level.

Empty x x  x The planned quantity is the 
available volume in the 
(source) tank. (i.e. Target the 
minimum operating level).
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• Target Type
This field is only visible if the planned quantity for the subject is to be specified. The drop-
down list allows the selection of whether the planned quantity will be entered as GOV, 
TOV, GSV, Weight or Mass. Where the Movement Type is one of the transfer options it is 
then possible to specify the quantity as an absolute quantity or a level.

• Planned Volume/Planned Weight/Stop Gauge By
This field is only visible if the planned quantity for the subject is to be specified. It is used 
to enter the planned quantity for the subject.

• Reference Density
This field is only visible for receipts. It allows the reference density of the product being 
received to be entered. Other types of movement use the density of the source tank in their 
calculations.

Strip x x  x The target is to leave the source 
tank with a Total Observed 
Volume of 0.
Note the implied use of TOV as 
target type.

No Control     The planned quantity is 
determined by the quantities 
specified on the tanks page of 
the wizard.

Specified     The planned quantity for the 
subject must be entered.

Receipt Load Transfer
(1-to-Many)

Transfer
(Many-to-1)
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Tanks Page

The Tanks page is used to enter details of the tanks to be used in the movement.

BA00395GEN_0087

• The Target Type field is used to indicate whether planned quantities are to be entered as 
a volume, weight or level. The selection includes several variations of volume and weight 
as well as absolute versions. Absolute GOV for instance would allow a tank to be filled until 
it contains a quantity of product sufficient to meet the absolute volume entered. The totals 
at the bottom of the page will be displayed as volumes unless stop gauge by weight is 
selected, when they are displayed as weights.

• The Total Volume/Weight field displays the total planned quantity for all the selected 
tanks.

• The Planned Volume/Weight field displays the total planned quantity for the subject of 
the movement.

• The Discrepancy field indicates the difference between the total planned quantity for the 
selected tanks and the total planned quantity for the subject of the movement. If this value 
is positive, it indicates that the planned volume for the subject is greater than the planned 
volume for the tanks. If this value is negative, it indicates that the planned volume for the 
tanks is greater than the planned volume for the subject.
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Adding a tank to the movement

To add a tank to the movement, click the Add button.
A new tank will be added to the movement:

BA00395GEN_0088

By default, the Tank ID will be set to the Tank ID of the first tank in the list, the 
movement control will be set to Specified and the planned quantity to 0.
The Start Level and Temperature are defaulted to the current tank level and 
temperature; these may be overridden to permit planning to occur in advance of the 
movement being started.

Tanks are selected by the Tank ID from the drop-down list.
The movement control for the tank can then be specified:

1.

2.

Receipt Load Transfer
(1-to-Many)

Transfer
(Many-to-1)

Fill  x  x The planned quantity is the 
quantity required to fill the tank 
to the maximum operating level.

Empty x  x  The planned quantity is the 
quantity required to empty the 
tank to the minimum operating 
level.

Strip1)

1) Present as a movement control option when the target type is either TOV or Absolute TOV.

x  x  The tank’s entire current TOV is 
to be taken, this may imply a 
target level beneath the 
minimum operating level and any 
water or sediment in the bottom 
of the tank.

No Control     The planned quantity is 
determined by the planned 
quantity for the subject.

Specified     The planned quantity must be 
entered.

3.
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If a movement control of Fill, Empty, Strip or No Control is selected, the planned quantity 
is calculated and cannot be entered. If No Control has been selected for the subject 
movement type then it is not available for the tanks.

Note that if No Control is selected then a receipt tank will be filled until either all the 
planned subject quantity has been used, or the maximum operating level has been 
reached. Similarly, for a load tank, it will be emptied until either all of the planned 
subject quantity has been accounted for, or the minimum operating level has been 
reached. If more than one tank has No Control selected, they will be filled/emptied in 
order until all the planned quantity for the subject has been accounted for.

Deleting a tank from the movement

To delete a tank, click the Delete button  to the left of the row to be removed.
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Timed Activities Page

This page will only be displayed if Include timed activities page is ticked in the Movements 
System Settings and at least one timed activity has been set up.

BA00395GEN_0089

This page works in a similar way to the tanks page. There is always one dummy activity with 
a tank ID of the first tank in the list, an activity of the first activity in the list and a planned 
time of 0:00.

Adding activities

To add activities, select the Tank ID for the activity, select the activity and enter a planned 
time. A new dummy row will automatically be created.

Deleting activities

To delete an activity, click the Delete button  to the left of the row to be removed.
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Summary Page

The final page of the wizard is a Summary page to allow for verification of the entered 
details:

BA00395GEN_0090

To create the movement, click the Finish button. The new movement will then appear in the 
list of planned movements on the summary screen and a new entry will be created in the 
audit trail detailing the new movement.
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8.1.2 Simple Tank Transfer
The Simple Tank Transfer screen is started by clicking clicking the Create transfer button 

 on the toolbar.

BA00395GEN_0016

This screen contains the following fields:
• Movement Name

The name used to identify the movement. If no name is entered, this will be set to the 
Movement ID.

• Source Tank
The Tank ID of the tank to be used as the source of the movement.

• Destination Tank
The Tank ID of the tank to be used as the destination of the movement.

• Movement Control
Determines how the planned quantity for the movement is to be calculated:

For further details, → ä 64.

• Stop Gauge By
Determines how the planned quantity is to be entered if movement control is set to 
specified.

• Planned Volume/Weight
The planned quantity for both the source and destination tanks.

Click the OK button to create the new movement.
This will create a movement of movement type Transfer (one to many). The new 
movement will appear in the list of planned movements on the summary screen and a 
new entry will be created in the audit trail detailing the new movement.

Movement Control Source Tank Destination Tank

Empty Empty No Control

Strip Empty + Dead stock + Free water TOV

Fill No Control Fill

Specified Specified Specified

1.
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8.2 Amend Planned Figures
Planned figures for a movement component can be amended up to the point where the 
movement component is closed. They can be amended either from the Summary screen or 
from the Details screen for the movement.

On either the Summary screen or Movement Details screen select the movement 
components to be amended and then select the Amend Planned Figures item from the 
Movements menu. Alternatively, click on the movement component with the right 
mouse button and select Amend Planned Figures from the menu that is displayed.
A screen will be displayed to allow the entry of the amended figures:

BA00395GEN_0091

Click OK to save the changes to the planned figures. Click Cancel to close the screen 
without saving the changes.
When the changes are saved a new entry is created in the audit trail showing the 
changes.

1.

2.
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8.3 Add Tank
Tanks can be added to a movement up to the point where the movement is complete (i.e. all 
movement components have been closed or cancelled). They can be added either from the 
summary screen or from the details screen for the movement.

On either the Summary Screen or Movement Details Screen select a component 
belonging to the movement to which a tank is to be added and the select Add → Tank 
from the Movements menu. Alternatively, click on the component with the right mouse 
button and select Add → Tank from the menu that is displayed.
A screen will be displayed to allow the entry of details of the tank to be added to the 
movement:

BA00395GEN_0092

Details of the tanks already on the movement are displayed along with the discrepancy 
from the planned volume for the subject.
Details for the tank are entered in the same way as creating a new movement.

Click OK to add the new tank to the movement, or Cancel to close the screen without 
adding the tank.
When a new tank is added to a movement, a new entry is written to the audit trail with 
the details of the new tank.

1.

2.
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8.4 Add Timed Activity
Timed activities can be added to a movement up to the point where the movement is 
complete (i.e. all movement components have been closed or cancelled). They can be added 
either from the summary screen or from the details screen for the movement.

On either the Summary Screen or Movement Details Screen select a component 
belonging to the movement to which a timed activity is to be added and the select Add 
→ Timed Activity from the Movements menu. Alternatively, click on the component 
with the right mouse button and select Add → Timed Activity from the menu that is 
displayed.
A screen will be displayed to allow the entry of details of the timed activity to be added 
to the movement:

BA00395GEN_0093

This screen contains details of the timed activities that already exist for the movement and 
allows details of the new timed activity to be entered.

Click OK to add the new timed activity to the movement, or Cancel to close the screen 
without adding the timed activity.
When a new timed activity is added to a movement, a new entry is written to the audit 
trail with the details of the new timed activity.

1.

2.
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8.5 Edit Alarm Configuration
A default set of alarms is created for each movement and for each component on the 
movement. The alarm settings for a component can be amended by selecting a single 
component on the Summary screen or Movement Details screen and then selecting Edit 
Alarm Configuration from the Movements menu. Alternatively click on the movement 
component with the right mouse button and select Edit Alarm Configuration from the 
menu that is displayed.

8.5.1 Tank Alarm Configuration

BA00395GEN_0094

Click OK to save the changes to the alarm configuration, or Cancel to close the screen 
without saving the changes.

When the alarm configuration is changed, a new entry is written to the audit trail with the 
details of the changes.

8.5.2 Timed Activity Alarm Configuration

BA00395GEN_0095

Click OK to save the changes to the alarm configuration, or Cancel to close the screen 
without saving the changes.

When the alarm configuration is changed, a new entry is written to the audit trail with the 
details of the changes.

1.

1.
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8.6 Opening Movements
Movement components can be opened either from the Summary screen or from the Details 
screen for the movement.

On either the Summary screen or Movement Details screen select the movement 
components to be opened (see Movement Component Selection, → ä 22) and then 
either click the Open/Reopen movement button  on the toolbar or select the 
Open/Reopen item from the Movements menu.

These options will only be available if all of the selected movement components belong 
to the same movement and have a status of Planned or Suspended.

Alternatively, click on the movement component with the right mouse button and select 
Open/Reopen from the menu that is displayed.

8.6.1 Tank movements
If any of the movement components has been blocked by Product and/or Tank Status the 
following override box will be displayed:

BA00395GEN_0061

Tick the required tank(s) and click OK to override the block and open the movement or 
click Cancel to abandon the movement.

If the relevant enter manual data option has been ticked in the movement system 
settings, the screen will be displayed to allow the manual data for the tank to be 
updated:

BA00395GEN_0062

1.

1.

2.
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Similarly if the relevant amend quantity option has been ticked in the movement system 
settings, the screen will be displayed to allow the planned quantity to be amended 
before the movement is opened:

BA00395GEN_0063

If both of the relevant options have been ticked in the movement system settings, the 
screen will be displayed to allow both the manual data and planned quantity to be 
amended:

BA00395GEN_0064

If the planned quantity would take the contents of the tank outside the maximum or 
minimum operating levels then the screens below are displayed.

BA00395GEN_0065

Movement components which would cause the shell capacity of the tank to be 
exceeded, or the volume remaining in the tank to drop below zero cannot be opened 
until the planned quantity has been edited to rectify the problem.

Movement components which would cause the maximum or minimum operating levels 
to be exceeded can be opened (depending on the current user’s access rights), but an 
entry will be written to the audit trail as well.

3.

4.

5.
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When the movement components are opened they move from the Planned to the 
Open view on the Summary screen. Details of any changes made will be written to the 
audit trail. In addition an entry will be added to the audit trail indicating that the 
movement was opened.

8.6.2 Timed Activities
If the relevant amend planned time option has been ticked in the movement system settings, 
the screen will be displayed to allow the planned time to be updated before the timed activity 
is opened:

BA00395GEN_0068

When the timed activity is opened it moves from the Planned to the Open view on the 
Summary Screen. Details of any changes made will be written to the audit trail. In addition 
an entry will be added to the audit trail indicating that the timed activity was opened.
The timed activity icon on the Home page will change from Planned  to Open .
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8.7 Suspending Movements
Movement components can be opened either from the Summary screen or from the Details 
screen for the movement.

On either the Summary screen or Movement Details screen select the movement 
components to be suspended (see Movement Component Selection, → ä 22) and then 
either click the Suspend movement button  on the toolbar or select the Suspend 
item from the Movements menu.

These options will only be available if all of the selected movement components belong 
to the same movement and have a status of Open or Reopened.

Alternatively, click on the movement component with the right mouse button and select 
Suspend from the menu that is displayed.

8.7.1 Tank Movements
If the relevant enter manual data option has been ticked in the movement system settings, 
the screen will be displayed to allow the manual data for the tank to be updated:

BA00395GEN_0027

When the movement components are suspended they move from the Open to the 
Planned view on the Summary screen.

Note that reopening a suspended movement component will cause it to 'split'. The 
original movement component will be closed and a new movement component will be 
created and opened for the remaining planned quantity.

Details of any changes made will be written to the audit trail. In addition an entry will 
be added to the audit trail indicating that the movement was suspended.

8.7.2 Timed Activities
When timed activity components are suspended they move from the Open to the Planned 
view on the summary screen.
The timed activity icon on the Home page will change from Open  to Suspended .

Note that reopening a suspended timed activity component will cause it to ‘split’. The 
original timed activity component will be closed and a new timed activity component 
will be created and opened for the remaining planned time.
Details of any changes made will be written to the audit trail. In addition an entry will 
be added to the audit trail indicating that the movement was suspended.

1.
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8.8 Closing Movements
Movement components can be opened either from the Summary screen or from the Details 
screen for the movement.

On either the Summary screen or Movement Details screen select the movement 
components to be closed (see Movement Component Selection, → ä 22) and then 
either click the Close movement button  on the toolbar or select the Close item 
from the Movements menu.
These options will only be available if all of the selected movement components belong 
to the same movement and have a status of Open or Reopened.

Alternatively, click on the movement component with the right mouse button and select 
Close from the menu that is displayed.

8.8.1 Tank Movements
If the relevant enter manual data option has been ticked in the movement system settings, 
the screen will be displayed to allow the manual data for the tank to be updated:

BA00395GEN_0071

When movement components are closed they move from the Open to the Closed view 
on the Summary screen.

Details of any changes made will be written to the audit trail. In addition an entry will 
be added to the audit trail indicating that the movement was closed.

8.8.2 Timed Activity
When timed activity components are closed they move from the Open to the Closed view on 
the Summary Screen. An entry will be added to the audit trail indicating that the timed 
activity was closed.
If there are no more timed activities planned for the tank the timed activity icon will be 
removed from the Home Page otherwise it will change to Planned .

1.
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8.9 Cancelling Movements
Movement components can be cancelled either from the Summary screen or from the 
Details screen for the movement:

On either the Summary screen or Movement Details screen select the movement 
components to be cancelled (see Movement Component Selection, → ä 22) and then 
either click the Cancel movement button  on the toolbar or select the Cancel item 
from the Movements menu.

These options will only be available if all of the selected movement components belong 
to the same movement and have a status of Planned.

Alternatively, click on the movement component with the right mouse button and select 
Cancel from the menu that is displayed.

If there are no other Timed Activity components for the tank the Planned icons (  ) will 
be removed from the Home Page otherwise the highest priority icon will be displayed (  , 

 ,  ).

1.
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9 Movement Details Screen
The Movement Details screen is accessed from the Summary screen or the Tankvision 
Professional Home Page:

• On the Summary screen select one or more movement components belonging to the 
movement to be displayed and then select the Show Details from the Movements menu. 
Alternatively double-click on a movement component to show details of the movement it 
belongs to, or click on it with the right mouse button and select the movement name from 
the menu that is displayed.

• From the Tankvision Professional Home Page, click on a movement status in the 
movement bar and then click the name of the movement in the menu that is displayed.

The Movement Details screen displays details of a single movement:

BA00395GEN_0029
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9.1 Toolbar Icons

9.2 Movement Header
The movement header details are displayed at the top of the Movement Details screen.

They can be hidden or shown by selecting the Movement Header item from the View 
menu.

The Name, Product and Class of the movement can be amended (dependent on the 
access rights for the current user), along with the custom data (which is dependent on 
the movement class

To save the changes click on the Save Changes button  on the toolbar.

When the changes are saved an entry will be added to the audit trail detailing the 
changes that were made.

Save Changes

Open/Reopen movement (→ ä 37)

Suspend movement (→ ä 40)

Close movement (→ ä 41)

Cancel movement (→ ä 42)

Movement Log (→ ä 48)

Movement History (→ ä 50)
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9.3 Subject
The movement subject details are displayed on the left-hand side of the middle of the 
Movement Details screen.
For movements which are a load or a receipt, this contains the name of the subject, an image 
taken from the movement class for the movement, the current status of the subject and the 
planned quantity for the subject:

BA00395GEN_0030

For movements which are a transfer, this contains details of the source tank (for one to 
many transfers) or the destination tank (for many to one transfers):

BA00395GEN_0031

9.4 Tank Movements
The details of the tanks involved in the movement (other than the subject tank if applicable) 
are displayed in a list on the right-hand side of the middle of the Movement Details screen.
If there is only one tank in the list, the details are displayed in a similar form to a subject 
tank:

BA00395GEN_0032

However, if there is more than one tank in the list the details are displayed alongside the 
tank graphic instead of underneath it:
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BA00395GEN_0033

9.5 Minimising Components
To help manage the movement or to save space on the screen any (or all) of the individual 
components may be minimised by clicking on the  arrow in the top left of the 
component.

BA00395GEN_0034

Components can be reopened clicking the  arrow . The status of a minimised component 
can be checked by hovering the mouse cursor over the component.
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9.6 Timed Activities
The details of the timed activities for the movement are displayed in a horizontal list at the 
bottom of the Movement Details screen:

BA00395GEN_0036

If there are no timed activities for a movement this list is hidden.
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10 Movement Log
The Movement Log screen is accessed from the Summary screen, Movement Details 
screen or Historical Movements screen. On any of these screens select one or more 
movement components belonging to the movement for which the log is required and select 
Movement Log from the Movements menu, or click on the Movement Log button  on 
the toolbar.

The Movement Log screen shows inventory details for the tanks involved in a movement:

BA00395GEN_0072

10.1 Toolbar Icons

10.2 Movement Filter
The movement filter is used to specify the movement for which the log is required. When the 
Movement Log screen is first opened the Start Date and Stop Date fields are set to span the 
current day. The movements in the drop down list are those which have been created later 
than the start date and have at least one component which is still not closed by the stop date. 

• To amend the list of available movements, edit the start date or stop date and then click 
away from the field.

• To view the log details for a movement, select it in the drop down list.

Export (→ ä 49)

Print Preview (→ ä 49)

Print (→ ä 49)

Movement History (→ ä 50)

Movement Certificate (→ ä 51)

Make text larger
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10.3 Data Interval
The data interval determines the data to be displayed in the log. When a movement is 
selected, the Start Date/Time is set to the date and time that the first component in the 
movement was opened. If no components have been opened yet, it is set to the current date 
and time.

• To amend the Start Date/Time, click on the field and then type in the new date and time 
the log is to start. Then click away from the field.

• Similarly, to amend the interval, click on the field and then type in the new interval. This 
can either be in minutes or in hours and minutes separated by a colon. Then click away 
from the field.

10.4 Export
The current contents of the movement log can be exported by selecting Export from the 
Movements menu, or clicking on the Export button  on the toolbar. The screen is 
displayed to allow selection of the file to which the log data is to be exported:

BA00395GEN_0073

10.5 Print Preview
A report on the current contents of the movement log can be previewed by selecting Print 
Preview from the Movements menu, or by clicking on the Print Preview button  on the 
toolbar.

10.6 Print
A report on the current contents of the movement log can be printed by selecting Print from 
the Movements menu, or by clicking on the Print button  on the toolbar. Using the 
Print button on the toolbar will send the report straight to the default printer. To choose a 
printer, or modify printer settings print the report from the menu.
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11 Movement History
The Movement History is accessed from the Summary screen, Movement Details screen 
or Historical Movements screen. On any of these screens select one or more movement 
components belonging to the movement for which the history is required and select 
Movement History from the Movements menu, or click on the Movement History button 

 on the toolbar.
The Movement History screen shows details of the changes that have been applied to a 
movement since it was planned:

BA00395GEN_0039

11.1 Filter and Sort
For redundant systems an additional field is displayed in the top part of the screen to allow 
selection of the computer on which the history is stored. The drop down list contains Current 
database server and the name of each of the servers on which the history could be stored.

The full history may not be available on each server as it is dependent on whether the 
server could be reached when the update was made.

The Sort Order field makes it possible to sort the history in either ascending or descending 
order of the date and time the change was made.

11.2 Fields
The following fields are included in the movement history:
• Date/Time

The date and time the change was made.
• Description

A description of the change that was made.
• User

The name of the user logged in at the time the change was made (if any).
• Computer Name

The name of the computer that was being used when the change was made.
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12 Movement Certificate
The Movement Certificate is accessed from the Summary screen, Movement Details 
screen or Historical Movements screen. On any of these screens select one or more closed 
movement components belonging to the movement for which the certificate is required and 
select Movement Certificate from the Movements menu, or click on the Movement 
Certificate button  on the toolbar.

This option is only available for closed movement components.

The Movement Certificate screen shows the inventory details for all closed movement 
components for a movement:

BA00395GEN_0074

If any pipelines have been configured, a pipeline section will appear below the inventory 
details:

BA00395GEN_0041
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12.1 Toolbar

12.2 Movement Header
The Movement Header details are displayed at the top of the Movement Certificate screen. 
The Name, Product and Class of the movement can be amended (dependent on the access 
rights for the current user), along with the custom data (which is dependent on the 
movement class). 
Any changes that are made are saved when the OK button is clicked.

12.3 Inventory Figures
To amend any incorrect inventory figures, click into the field containing the value to be 
amended and then type the new value. Then click away from the field or press the Tab key 
to move to the next field and the GSV values will be updated.
To amend any adjustment figures, click into the field containing the value to be amended 
and then type the new value.
Any changes that are made are saved when the OK button is pressed. An entry will also be 
written to the audit trail detailing the changes that were made.

Print Preview (→ ä 53)

Print (→ ä 53)
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12.4 Pipelines
The pipelines section allows configured pipelines to be added to the certificate. Once a 
pipeline is added, various settings can be changed e.g. if the pipeline is full or empty before 
and after the movement. Using the capacity of the pipeline, adjustments can be made to the 
Movement Certificate giving more accurate inventory figures.
To add a pipeline click anywhere on the pipeline section and the Add Pipeline screen will 
appear:

BA00395GEN_0075

Click Add to add a pipeline.
Select which pipeline to add from the Pipeline dropdown box and the movement tank from 
Tank ID dropdown box. The adjustments will be automatically calculated on the movement 
certificate.

12.5 Print Preview
The movement certificate can be previewed by clicking on the Print Preview button  on 
the toolbar.

12.6 Print
The movement certificate can be printed by clicking on the Print button  on the toolbar.
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13 Historical Movements
The Historical Movements screen is accessed from the Summary screen. To start the 
Historical Movements screen select the Historical Movements item from the Movements 
menu, or click the Historical Movements button  on the toolbar. The Historical 
Movements screen allows access to movements that are no longer displayed on the 
Summary screen.

BA00395GEN_0043

13.1 Toolbar Icons
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13.2 Filter
The filter for historical movements can be hidden or shown by selecting Show Filter from 
the View menu or by clicking on the arrow on the filter header.

The filter allows selection of the criteria for the movements to be displayed in the list of 
historical movements. These criteria are grouped into three types:
• Dates

To filter movements by date By Date Range must be ticked. Dates can then be entered for 
the earliest date and latest date. Movements will be included in the list if the date range 
spanned from creating the movement to the last movement component being closed 
overlaps with the date range defined by earliest date and latest date.

• Options
– Show Planned Movements

If movement components with a status of Planned are to be displayed, this must be 
ticked.

– Show Open Movements
If movement components with a status of Open or Reopened are to be displayed, this 
must be ticked.

– Show Closed Movements
If movement components with a status of Closed are to be displayed, this must be ticked.

– Show Cancelled Movements
If movement components with a status of Cancelled are to be displayed, this must be 
ticked.

– Show Subjects
If movement subjects are to be displayed this must be ticked.

– Show Tanks
If movement tanks are to be displayed this must be ticked.

– Show Activities
If timed activities for a movement are to be displayed this must be ticked.

• Miscellaneous
– Movement Name

Allows filtering of movements by the name of the movement.
– Movement Type

Allows filtering of movements by the type of the movement.
– Movement Class

Allows filtering of movements by the class of the movement.
– Tank ID

Allows filtering of movements by the ID of a tank involved in the movement either as a 
subject or a tank.

To apply the filter to the list, click the Search button.

13.3 Search Results
The search results are displayed in a list similar to the views on the Summary screen. To 
amend the columns that are displayed select Maintain View from the Options menu (see 
Movements Configuration Manual BA00394G for more details).
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14 Movements Ticketing

14.1 Introduction
The Movements Ticketing software package allows the user to create movements tickets as 
required by the Saudi Custody Measurement Standards Committee.
The software package requires a connection to a working installation of Tankvision 
Professional but is otherwise an independent module.

14.2 Installation
The installation file is named Movements.Ticketing.Setup.exe.
During installation the user may configure 4 settings.

A0039107_300

ServerName
The name of the server where Tankvision Professional is installed. If this is on the same 
physical machine the default value of (local) may be used.

Database
The database within Tankvision Professional where movement data is stored. By default this 
is Tanks.

UserName
The username to use to connect to the Tankvision Professional database. The default setting 
is the sa user.

Password
The password that corresponds to the above configured user.

The installation program will automatically install any required third party components.
On successful completion of the installation, the system must be rebooted.

14.3 Configuration
Before the Movements Ticketing system can be utilised, it must be configured.
Attempting to create a new ticket without properly configuring the module will result in 
error messages such as that shown in the following figure.
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14.3.1 Security
The Movements Ticketing module obeys security settings in place on the Tankvision 
Professional server to which it is connected. See the Tankvision Professional configuration 
manuals for details.

14.3.2 Settings
Settings are accessed using the Configure menu option.

A0039109_300

Settings menu option

A0039110_300

This setting allows the user to specify the number of days movement tickets will be held in 
the system before being automatically deleted.
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Receipt Sources menu option

A0039111_300

This setting allows the user to configure receipt sources. The size of the receipt source name 
is restricted to 8 characters.

Destinations menu option

A0039112_300

This setting allows the user to configure destinations. The size of the destination name is 
restricted to 8 characters.
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Contractors/Hauliers/Suppliers menu option

A0039113_300

This setting allows the user to configure Contractors, Hauliers and Suppliers. The name field 
is limited to 28 characters in length.

Tank Seals menu option

A0039114_300

This setting allows the user to record seals fitted to each tank in the Tankvision Professional 
database. Each tank may have a maximum of 5 seal identity numbers, which can be up to 
5 characters in length.
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When a seal is replaced, the previous seal identity and the date of replacement is recorded 
internally.

14.4 Operation
Once the system is configured correctly, movement tickets may be created.

14.4.1 Creating a new ticket
A new movement ticket is created by clicking the new ticket icon, by selecting File → 
New Ticket or by pressing Ctrl-N.

A0039115_300

A0039116_300

When the user selects to create a new ticket, a movement search box is opened to enable the 
user to locate the movement to create a ticket for. Changing the earliest and Latest time 
fields will populate the Movement selection box with all the movements which were closed 
between the 2 dates.
The user can also select whether to produce a ticket for the delivery section of the movement, 
the receipt section of the movement or both. Clicking OK will create a new ticket for the 
selected movement and delivery/receipt option as shown.
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It is now possible to edit the ticket details.
Tickets details can also be accessed by double clicking the relevant ticket in the main 
window.

14.4.2 Editing Ticket Details
Movement
The name of the movement for which the ticket was created

Delivery/Receipt
The section of the movement being recorded

Ticket Number
Automatically generated index for this ticket

Batch Number
User editable 9-digit batch number

Location
The Tankvision Professional site to create the ticket against

Location Id
The id corresponding to the site selected above. (This relies on the id being configured for 
the site in Tankvision Professional)

Delivery Destination
The destination for the ticket. The user may choose any destination configured in the system

Delivery Order Number
The order number corresponding to this ticket

Contractor/Haulier/Supplier
The contractor, haulier or supplier this ticket relates to. The user may choose any contractor, 
haulier or supplier configured in the system

Receipt Source
The receipt source for this ticket. The user may choose any receipt source configured in the 
system

Receipt Order Number
The receipt order number which relates to this ticket

Task ID
The task id for this ticket

Transaction code
The transaction code for this ticket
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Product Type
The product type this ticket applies to. The user may choose from any product type 
configured in Tankvision Professional

The user may also edit the values for each individual parcel within the ticket. Any changes 
to parcel volumes will be automatically recalculated.

14.4.3 Making a ticket official
A ticket can be made official by selecting the ticket in the main window and then clicking the 
Make Ticket Official icon (see figure) or by selecting File → Make Ticket Official from the 
menu.

A0039118_300

A ticket may only be made official by a user with sufficient security rights configured in 
Tankvision Professional. To make a ticket official this user must enter their login details 
everytime a ticket is made official.

A0039119_300

Once a ticket is made official it can no longer be edited.
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14.4.4 Printing
Both the main screen and the ticket view have both print and print preview options.
In all cases the user must choose the printed ticket format.

A0039120_300

15 Glossary

Load Product is taken from a tank to a place outside the site.

Receipt Product arrives from outside the site to be stored in a tank on site.

Transfer Product is moved between two or more storage vessels on the site.

ETF Estimated time to finish.

Actual Volume The volume transferred since the movement was opened.

Planned Volume The volume to be transferred by the movement.

Subject The movement subject is the tank or transport which will receive or export the whole of 
the planned volume.
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16 Appendix: Transfer Volume Calculations
This chapter deals with the methods used to calculate volumes when transferring product 
between tanks, and the differences between movements configured using the Quick 
Transfer and the Movement Wizard.

16.1 General Principles
In general the quantity transferred between any 2 vessels is calculated as a standard volume. 
The reason being that conditions in the source and destination may not be the same. For 
instance if the temperature in the source tank is 10 °C and the temperature in the 
destination tank is 20 °C the aim to fill the destination will require a smaller volume from the 
source tank than will appear in the destination through thermal expansion of the product, 
as illustrated in the figure below. There is no attempt to calculate the net change in 
temperature if product from one tank is mixed with another, it is assumed that the 
conditions (temperature, pressure and density) in the tanks will remain constant throughout 
the movement.

BA00395GEN_0096

The second principle is that the aim of the movement calculations is to derive a target level 
that will remain constant once the movement is opened and to which all alarm notifications 
refer. Level gauges are the most commonly used instrument to measure the quantity in 
tanks, therefore attempting to define a target in some derived quantity, be that a volume or 
mass, would lead to unstable target levels. This was attempted in previous versions of 
movements but was not well received. Once a movement is opened the target level for the 
movement is calculated and it is this level to which the operator monitors the progress of the 
activity.

16.2 Using Total Observed Volume
When transferring mixtures of liquids from one tank to another Total Observed Volume 
(TOV) is probably the most appropriate movement target type as the inventory calculations 
provided in the tank gauging system work on the assumption that the movement quantity is 
of a homogenous composition not an emulsion of hydrocarbon and water for instance. Using 
the Quick Transfer window (→ ä 18) only a pair of tanks acting as source and destination 
can be specified as illustrated in the figure below. Any mixture must, therefore, be 
transferred in its entirety to the other vessel.



Tankvision Professional NXA85 - Movements System Operation Appendix: Transfer Volume Calculations

Endress+Hauser 65

BA00395GEN_0097

Simple transfer comprising a source mixture of product and water

This contrasts with the Movement Wizard, where the possibility of multiple destinations 
means that it is too complex to plan how much of each component in the mixture will be 
transferred to each destination. Illustrated below, the water is all sent to one tank and the 
product is split between the two destinations.

BA00395GEN_0098

One to many transfer comprising a source mixture of product and water

As a consequence the use of TOV and Absolute TOV in the Quick Transfer window will 
determine the target volume in the destination to be the sum of the current destination’s 
TOV and the TOV quantity to be transferred from the source. Whereas in the movement 
wizard the volume transferred from the source in the Tank Movements page (→ ä 27) 
consists of just the product component of the mixture. To transfer a mixture of liquids the 
operator must manually enter the target volumes for the destination tanks. The No Control 
option will not work in these circumstances.

16.3 Strip vs Empty
Stripping is distinct from emptying the tank in that it removes absolutely all material from 
the tank. Typically, a strip will be performed prior to taking the tank out of service for 
maintenance, although the practice is common for other reasons on some sites. In many 
cases stripping the tank may require supervisory confirmation of moving the tank beyond 
the minimum operating level. Stripping makes use of the movements system’s ability to plan 
using TOV as the aim is to remove all liquids from the tank; hydrocarbon and water.

Emptying the tank removes all product from the tank leaving behind any free water and 
dead stock below the minimum operating level. Emptying the tank will never require 
supervisory confirmation, as the target level is the larger of the minimum operating level for 
the tank and the free water level. Emptying the tank should be viewed as getting the 
maximum amount of product out of the tank according to the safe operating requirements 
of the site.
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